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ABSTRACT

Landmines pose a significant threat to human life and safety, particularly in regions affected
by conflict. Traditional methods of landmine detection, such as manual probing and metal
detectors, are time-consuming, hazardous, and often ineffective in complex terrains. This
paper presents the design and development of an integrated landmine detection system
utilizing Global Positioning System (GPS) and Global System for Mobile Communications
(GSM) technologies.

The term "Metal Detector” implies that it can be done from a distance, allowing for a
safer approach to locating landmines. Using a mine detection robot, soldiers can traverse
mine-ridden areas without entering them, providing a secure and efficient way of landmine
detection. Other methods, such as radar bullets, biological methods, and mechanical
methods, are much risky and put soldier’s lives at risk. The Landmine Detection Robot,
which utilizes both loT and GPS technology, is a much safer option.

The proposed system employs a network of sensors capable of detecting landmines
based on specific physical signatures such as metallic content or pressure changes. GPS is
used to precisely locate the sensor’s position, providing real-time coordinates for effective
mapping of detected mine locations. GSM technology is integrated to send immediate alerts
to authorities or emergency response teams, ensuring quick action for demining operations

or evacuation.

The system is designed to enhance detection accuracy, improve safety during
operations, and offer a cost-effective solution for widespread deployment in landmine-
affected areas. Field testing results indicate that the system can accurately identify landmine
locations and deliver timely notifications, offering a promising advancement in

humanitarian mine clearance efforts.
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CHAPTER 1
INTRODUCTION

With advancements in technology, the demand for effective vehicle tracking systems has
increased to ensure vehicle and passenger safety. This work introduces a vehicle tracking
and monitoring system utilizing the LPC2148 microcontroller, GPS, and the NodeMCU
module for wireless communication.The NodeMCU, an loT platform with Wi-Fi
capabilities, enables seamless data transmission to a cloud server, allowing real-time
monitoring via a web interface. The system also includes sensors to detect driver
intoxication and monitor engine temperature. Alerts are sent to the vehicle owner's mobile
device in emergencies, and a buzzer warns the driver. This approach enhances vehicle

tracking and prioritizes safety, offering a reliable and scalable solution.

1.1 EMBEDDED SYSTEM

An Embedded System is a combination of computer hardware and software, and perhaps
additional mechanical or other parts, designed to perform a specific function. A good
example is the microwave oven. Almost every household has one, and tens of millions of
them are used every day, but very few people realize that a processor and software are

involved in the preparation of their lunch or dinner.

This is in direct contrast to the personal computer in the family room. It too is
comprised of computer hardware and software and mechanical components (disk drives, for
example). However, a personal computer is not designed to perform a specific function
rather; it is able to do many different things. Many people use the term general purpose
computer to make this distinction clear. As shipped, a general-purpose computer is a blank
slate; the manufacturer does not know what the customer will do wish it. One customer may
use it for a network file server another may use it exclusively for playing games, and a third
may use it to write the next great American novel.

Frequently, an embedded system is a component within some larger system. For
example, modern cars and trucks contain many embedded systems. One embedded system
controls the anti-lock brakes, other monitors and controls the vehicle's emissions, and a third
displays information on the dashboard. In some cases, these embedded systems are

connected by some sort of a communication network, but that is certainly not a requirement.



At the possible risk of confusing you, it is important to point out that a general-purpose
computer is itself made up of numerous embedded systems. For example, my computer
consists of a keyboard, mouse, video card, modem, hard drive, floppy drive, and sound
cardeach of Which is an embedded system? Each of these devices contains a processor and
software and is designed to perform a specific function. For example, the modem is designed
to send and receive digital data over analog telephone line. That's it and all of the other

devices can be summarized in a single sentence as well.

If an embedded system is designed well, the existence of the processor and software
could be completely unnoticed by the user of the device. Such is the case for a microwave
oven, VCR, or alarm clock. In some cases, it would even be possible to build an equivalent
device that does not contain the processor and software. This could be done by replacing
the combination with a custom integrated circuit that performs the same functions in
hardware. However, a lot of flexibility is lost when a design is hard-cooled in this way. It is
much easier, and cheaper, to change a few lines of software than to redesign a piece of

custom hardware.

1.2 HISTORY AND FUTURE

Given the definition of embedded systems earlier is this chapter; the first such systems could
not possibly have appeared before 1971. That was the year Intel introduced the world's first
microprocessor. This chip, the 4004, was designed for use in a line of business calculators
produced by the Japanese Company Busycon. In 1969, Busycon asked Intel to design a set
of custom integrated circuits-one for each of their new calculator models. The 4004 was
Intel's response rather than design custom hardware for each calculator, Intel proposed a
general-purpose circuit that could be used throughout the entire line of calculators. Intel's
idea was that the software would give each calculator its unigque set of features.

The microcontroller was an overnight success, and its use increased steadily over
the next decade. Early embedded applications included unmanned space probes,
computerized traffic lights, and aircraft flight control systems. In the 1980s, embedded
systems quietly rode the waves of the microcomputer age and brought microprocessors into
every part of our kitchens (bread machines, food processors, and microwave ovens), living
rooms (televisions, stereos, and remote controls), and workplaces (fax machines, pagers,

laser printers, cash registers, and credit card readers).



It seems inevitable that the number of embedded systems will continue to increase rapidly.

Already there are promising new embedded devices that have enormous market potential;
light switches and thermostats that can be central computer, intelligent air-bag systems that
don't inflate when children or small adults are present, pal-sized electronic organizers and
personal digital assistants (PDASs), digital cameras, and dashboard navigation systems.
Clearly, individuals who possess the skills and desire to design the next generation of
embedded systems will be in demand for quite some time.

1.3 REAL TIME SYSTEMS

One subclass of embedded is worthy of an introduction at this point. As commonly
defined, a real-time system is a computer system that has timing constraints. In other words,
a realtime system is partly specified in terms of its ability to make certain calculations or
decisions in a timely manner. These important calculations are said to have deadlines for
completion.

And, for all practical purposes, a missed deadline is just as bad as a wrong answer.
The issue of what if a deadline is missed is a crucial one. For example, if the real-time system
is part of an airplane's flight control system, it is possible for the lives of the passengers and
crew to be endangered by a single missed deadline. However, if instead the system is
involved in satellite communication, the damage could be limited to a single corrupt data
packet. The more severe the consequences, the more likely it will be said that the deadline
is "hard" and thus, the system is a hard real-time system. Real-time systems at the other end

of this discussion are said to have "soft" deadlines.

All of the topics and examples presented in this book are applicable to the designers of
real-time system who is more delight in his work. He must guarantee reliable operation of
the software and hardware under all the possible conditions and to the degree that human
lives depend upon three system's proper execution, engineering calculations and descriptive
paperwork.

1. Application Areas : Nearly 99 per cent of the processors manufactured end up in
embedded systems. The embedded system market is one of the highest growth areas as
these systems are used in very market segment- consumer electronics, office
automation, industrial automation, biomedical engineering, wireless communication,
Data communication, telecommunications, transportation, military and so on.



Office automation: The office automation products using em embedded systems are
copying machine, fax machine, key telephone, modem, printer, scanner etc.

Medical electronics: Almost every medical equipment in the hospital is an embedded
system. These equipment include diagnostic aids such as ECG, EEG, blood pressure
measuring devices, X-ray scanners; equipment used in blood analysis, radiation,
colonoscopy, endoscopy etc. Developments in medical electronics have paved way for
more accurate diagnosis of diseases.

Computer networking: Computer networking products such as bridges, routers,
Integrated Services Digital Networks (ISDN), Asynchronous Transfer Mode (ATM) and
frame relay switches are embedded systems which implement the necessary data
communication protocols. For example, a router interconnects two networks. The two
networks may be running different protocol stacks. The router’s function is to obtain the
data packets from incoming pores, analyse the packets and send them towards the
destination after doing necessary protocol conversion. Most networking equipment,
other than the end systems (desktop computers) we use to access the networks, are
embedded systems.

Telecommunications: In the field of telecommunications, the embedded systems can
be categorized as subscriber terminals and network equipment. The subscriber terminals
such as key telephones, ISDN phones, terminal adapters, web cameras are embedded
systems. The network equipment includes multiplexers, multiple access systems, Packet
Assemblers Dissemblers (PADs), satellite modems etc. IP phone, IP gateway, IP
gatekeeper etc. are the latest embedded systems that provide very low-cost voice
communication over the Internet.

Wireless technologies: Advances in mobile communications are paving way for many
interesting applications using embedded systems. The mobile phone is one of the
marvels of the last decade of the 20’h century. It is a very powerful embedded system
that provides voice communication while we are on the move. The Personal Digital
Assistants and the palmtops can now be used to access multimedia services over the
Internet. Mobile communication infrastructure such as base station controllers, mobile

switching centres are also powerful embedded systems.

Insemination: Testing and measurement are the fundamental requirements in all
scientific and engineering activities. The measuring equipment we use in laboratories to
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measure parameters such as weight, temperature, pressure, humidity, voltage, current
etc. are all embedded systems. Test equipment such as oscilloscope, spectrum analyser,
logic analyser, protocol analyser, radio communication test set etc. are embedded
systems built around powerful processors. Thank to miniaturization, the test and
measuring equipment are now becoming portable facilitating easy testing and
measurement in the field by field-personnel.

Security: Security of persons and information has always been a major issue. We need
to protect our homes and offices; and also the information we transmit and store.
Developing embedded systems for security applications is one of the most lucrative
businesses nowadays. Security devices at homes, offices, airports etc. for authentication
and verification are embedded systems. Embedded systems find applications in. Every
industrial segment- consumer electronics, data communication, telecommunication,
defence, security etc.

1.4 OVERVIEW OF THE PROJECT

In warfare, buried landmines cause a significant number of casualties, even after a conflict
has ended. These unexploded landmines possess a dangerous characteristic: they can remain
active and functional for an extended period of time. Consequently, the risk of fatal damage
and death from landmines is everpresent. Due to their affordability and ease of construction,

landmines have become an effective weapon.

They typically consist of explosives and a triggering mechanism, often activated by
weight. Different types of landmines exist, each requiring a specific weight to trigger them.
These mines are strategically buried at shallow depths in the soil, making them difficult to
detect with the naked eye.

Landmines can be deployed in specific patterns to impede enemy movements. For
instance, a zigzag pattern can slow down advancing enemies, while mines strategically
placed can force the enemy to alter their path, leading them into an ambush. These
characteristics make landmines highly effective, as they can be easily deployed and remain
undetected and fully functional for extended periods.

1.5 OBJECTIVE OF THE PROJECT

This project provides a comprehensive review of existing and advanced techniques
developed for landmine detection, with electronics playing a crucial role in the development
and efficient utilization of some of these methods. The discussed techniques include the use

5



of metal detectors and mechanical methods, outlining their functionality, advantages, and
limitations. The detection system's performance can be enhanced by employing multiple
techniques simultaneously.

Additionally, the system is designed to minimize false alarms, enhance operational
safety, and offer continuous monitoring and reporting of detected threats, making it an

invaluable tool for landmine clearance operations in both developed and developing regions.

1.6 ORGANIZATION OF THE PROJECT

Develop a Landmine Detection System:
To design and implement a system that can accurately detect the presence of landmines
using sensors such as metal detectors or ground-penetrating radar (GPR).

Geographic Location Tracking:
To integrate a GPS module into the detection system for real-time geographical location
tracking, providing precise latitude and longitude coordinates of detected landmines.

Wireless Communication via GSM:
To utilize GSM technology for sending automated SMS alerts containing the GPS
coordinates of detected landmines to a designated mobile phone number or central

monitoring system.

Enhance Safety and Efficiency:

To improve the safety and efficiency of landmine detection operations by ensuring that the
location of detected mines is promptly communicated to authorities or de-mining teams,
reducing the risk of accidents and facilitating timely responses.

Create a Low-Cost, Accessible Solution:
To develop a cost-effective, easily deployable system that can be used in conflict zones or
post-conflict areas where landmines pose a serious threat to civilians and hinder

development.

Provide a Scalable and Modular System:
To create a modular system that can be scaled for use in different landmine detection
scenarios, ranging from manual handheld devices to more complex automated robotic

systems.



Increase Real-Time Monitoring:

To enable continuous monitoring and reporting of landmine detection events, allowing for
the integration of the system with remote monitoring applications or mobile platforms for
real-time data collection.

Reduce False Positives and Improve Accuracy:

To minimize false alarms and increase the accuracy of landmine detection by using multiple
sensor modalities (e.g., combining metal detection with GPR), ensuring that only genuine
threats are reported.

Develop a Prototype for Field Testing:
To design and build a prototype that can be field-tested in controlled environments to
validate the system’s performance and reliability in detecting landmines and transmitting

alerts effectively.

The primary objective of this project is to design and develop a landmine detection
system that integrates GPS (Global Positioning System) and GSM (Global System for
Mobile Communications) technologies to improve the accuracy, communication, and safety
of landmine detection operations. The system aims to detect landmines using sensors like
metal detectors or ground-penetrating radar (GPR), and upon detection, it will capture the
exact geographical location of the landmine using a GPS module.

The GPS coordinates will then be transmitted via SMS to a designated mobile
number or central monitoring system using a GSM module, ensuring that relevant authorities
or de-mining teams receive real-time alerts. This project aims to provide a low-cost,
efficient, and scalable solution for detecting landmines in conflict-affected or post-conflict
regions, thereby reducing the risks posed to civilians and improving the effectiveness of de-
mining efforts.



CHAPTER 2

LITERATURE SURVEY
2.1 EXISTING SYSTEM

Traditional landmine detection systems, which have long been the backbone of demining
efforts, often rely on basic manual methods or simple robotic systems equipped with metal
detectors. These systems are generally straightforward, with manual detection typically
involving handheld metal detectors operated by human personnel or basic robotic platforms
designed to autonomously scan the ground. While these systems have proven effective in
detecting landmines, they come with several limitations that can affect both efficiency and

safety.
Disadvantages:

Limited Automation: A major limitation of many traditional systems is the lack of
advanced automation. Human-operated metal detectors and basic robots require significant
manual intervention to operate effectively, often requiring a person to manually guide the
detector or robot through the minefield. These systems lack the intelligence to autonomously

identify and avoid potential hazards, making them labor-intensive and slow.

Higher Risk: The most significant disadvantage of traditional manual methods is the
exposure of personnel to danger. Landmine detection often involves operators physically
moving through areas where mines are buried, putting them at great risk. Even with robots,
human oversight is still required, which can place operators in potentially hazardous
environments, particularly when the systems are not fully autonomous or capable of

detecting all types of mines.

Restricted Range and Accuracy: Basic robotic systems, which may be used to automate
the process of landmine detection, typically lack advanced features like GPS tracking or
communication modules such as GSM (Global System for Mobile Communications).
Without GPS, these robots have limited ability to track their location within a minefield,
which can compromise their accuracy in marking the exact location of detected mines.
Furthermore, the lack of GSM or real-time data transmission means that the information
about the mine's location cannot be sent immediately to a central monitoring station,

potentially delaying critical responses.



No Real-Time Communication: Traditional landmine detection systems that operate
without lIoT (Internet of Things) or GSM modules face a significant challenge in terms of
communication. The absence of real-time data transfer means that detected mine locations
cannot be immediately relayed to a central command or team, which delays the time it takes
for experts to respond. This lack of communication can be particularly problematic in large,
complex minefields where rapid, coordinated responses are critical to ensuring safety and

effectiveness in the clearance process.

Less Power Efficiency: Many traditional landmine detection systems are not optimized for
power efficiency, which means they often consume more energy than necessary. This is
particularly problematic for systems that rely on battery-powered robotic platforms or
handheld detectors, as it can limit their operational duration in the field. Without efficient
power management, these systems may need frequent recharging or battery replacement,

reducing their overall efficiency and effectiveness during long demining operations.

While traditional landmine detection methods such as manual metal detection or
basic robotics have proven essential in demining efforts, they are constrained by limitations
in automation, range, accuracy, communication, and power efficiency.These systems often
require significant human input and expose operators to risk, and they lack the advanced
features necessary to make demining more efficient and safer. Consequently, modern
solutions are increasingly integrating advanced technologies such as GPS, GSM, loT, and
automated robotic systems to overcome these challenges and improve the speed and safety

of landmine detection and clearance.

2.2 PROPOSED SYSTEMS
Overview:

The proposed system is a comprehensive landmine detection solution designed using
Arduino-based technology and integrates GPS, GSM, and loT modules. These
components work together to provide real-time monitoring, remote control, location
tracking, and enhanced safety for landmine detection operations. This system uses
multiple sensors and modules, including a metal detector, motor drivers, and an LCD
display, making it an effective tool for detecting landmines and communicating with

remote operators.



The system consists of :

Arduino Microcontroller (Primary and Secondary controllers)
Metal Detector for detecting buried metallic objects (landmines).
Motor Driver Modules (L298, L293) to control movement.

GPS Module to provide location coordinates of detected landmines.
GSM Module to send alerts and communication remotely.

LCD Display for real-time feedback and system status display.

Advantages of the Proposed System:

Enhanced Automation:

Automated Control: The system features primary and secondary Arduino controllers
to manage various components like motors, sensors, and communication devices. The
automation reduces the need for human intervention, ensuring the system can operate

autonomously.

Real-Time Monitoring and Communication:

GSM Module: The GSM module allows for instant communication of data, including
alerts and status updates, to a remote location. This means that if a landmine is detected,
the system can immediately notify authorities or operators to take action or evacuate the

area.

10T Integration: If connected to an IoT platform, the system can upload real-time data
for further analysis, monitoring, and even integration with other systems, such as

automated response or mapping systems.

Accurate Location Data: The GPS module provides real-time location tracking of the
system. This is especially critical for mapping the precise locations of detected
landmines or hazardous zones, helping to create a detailed map for future demining

operations.

Safety and Efficiency: Knowing the exact coordinates of landmines ensures that the
demining teams can safely and efficiently plan their work, minimizing the time spent in

dangerous areas.
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Improved Safety:

Remote Monitoring: By automating the detection process, the system reduces the need
for human operators to be physically present in hazardous areas. The system can detect

landmines and send alerts without putting human lives at risk.

Immediate Alerts: In case of a landmine detection, the GSM module sends alerts to
remote operators, ensuring that they are informed in real-time about the situation. This

reduces response time and allows for timely evacuation or further action.

User Interface:

LCD Display: The system includes an LCD display to provide operators with real-time
feedback about its operational status. This could include battery levels, system health,

and whether a landmine has been detected.

The interface makes it easier for users to monitor the system’s performance and interact

with it when necessary, such as adjusting settings or activating manual overrides.

Efficient Power Management:

Optimized Power Distribution: The motor driver modules (L298 and L293) efficiently
distribute power between the motors and sensors, ensuring that the system can run longer

on a single battery charge.

Extended Operational Life: Power management is crucial for long-term field
operations, especially when the system is deployed in remote areas where power sources
may be scarce. Efficient power distribution helps extend the operational time of the

landmine detector, making it more effective during extended missions.

System Components and Functionality

1.

Arduino Microcontroller:
Acts as the central controller for all system operations.
Manages input from the metal detector and GPS sensor, controls motor movement, and

communicates with the GSM module.

Metal Detector:
Detects the presence of metal objects (i.e., landmines) underground.
Sends signals to the Arduino controller, which processes the data and decides whether

an alert should be triggered.
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GPS Module:

Tracks the current geographic location of the detection system.
Sends coordinates to the Arduino when a landmine is detected, allowing the system to

store or transmit the exact location of the threat.

GSM Module:

Provides real-time communication via SMS or other messaging protocols.

Sends alerts to a remote monitoring station or operators in case a landmine is detected.

Motor Driver Modules (L298, L293):

Control the movement of the detection vehicle. The system can move autonomously
across the detection area, scanning for landmines.

Efficient motor control helps in reducing energy consumption, thus extending

operational time.

LCD Display:
Provides the user with important feedback on the system's health and operational status.
Displays real-time alerts such as “landmine detected” and operational metrics like

battery level or GPS coordinates.

Potential Applications:

Military and Defense: The system can be used by armed forces for landmine detection
in conflict zones, ensuring the safety of soldiers and civilians.

Humanitarian Demining: NGOs and agencies involved in post-conflict cleanup can
use this system to safely detect and map landmines in areas affected by war.
Agricultural Landmine Detection: The system could be used in rural areas for

detecting landmines in agricultural fields, ensuring the safety of farmers and livestock.

These systems often require significant human input and expose operators to risk, and they

lack the advanced features necessary to make demining more efficient and safer.

Consequently, modern solutions are increasingly integrating advanced technologies such as

GPS, GSM, 10T, and automated robotic systems to overcome these challenges and improve

the speed and safety of landmine detection and clearance.
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2.3 EMBEDDED INTRODUCTION

An embedded system is a combination of computer hardware and software designed
for a specific function or functions within a larger system. The systems can be programmable
or with fixed functionality. Industrial machines, consumer electronics, agricultural and

process industry devices, automobiles, medical equipment, cameras, household appliances,

Analog
Components

e Embedded
et System

Software

Converters

Fig: 2.1 Embedded Os

While embedded systems are computing systems, they can range from having no
user interface (Ul) -- for example, on devices in which the system is designed to perform a
single task -- to complex graphical user interfaces (GUIs), such as in mobile devices. User
interface scan include buttons, LEDs and touchscreen sensing. Some systems use remote

user interfaces as well.

History of embedded systems

Embedded systems date back to the 1960s. Charles Stark Draper developed an
integrated circuit (IC) in 1961 to reduce the size and weight of the Apollo Guidance
Computer, the digital system installed on the Apollo Command Module and Lunar Module.
The first computer to use ICs, it helped astronauts collect real-time flight data.

In 1965, Autonoetic, now a part of Boeing, developed the D-17B, the computer used
in the Minuteman | missile guidance system. It is widely recognized as the first mass-
produced embedded system. When the Minuteman Il went into production in 1966, the D-
17B was replaced with the NS-17 missile guidance system, known for its high-volume use
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of integrated circuits. In 1968, the first embedded system for a vehicle was released; the
Volkswagen 1600 used a microprocessor to control its electronic fuel injection system.

Also, in 1971, Intel released what is widely recognized as the first commercially
available processor, the 4004. The 4-bit microprocessor was designed for use in calculators
and small electronics, though it required eternal memory and support chips. The 8-bit Intel
8008, released in 1972, had 16 KB of memory; the Intel 8080 followed in 1974 with 64 KB
of memory. The 8080's successor, x86 series, was released in 1978 and is still largely in use
today.

In 1987, the first embedded operating system, the real-time VVxWorks, was released
by Wind River, followed by Microsoft's Windows Embedded CE in 1996. By the late 1990s,

the first embedded Linuxproducts began to appear.

Characteristics of embedded systems
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Fig: 2.2 Embedded Systems

The main characteristic of embedded systems is that they are task specific. They perform a
single task within a larger system. For example, a mobile phone is not an embedded system,
it is a combination of embedded systems that together allow it to perform a variety of
general-purpose tasks. The embedded systems within it perform specialized functions. For
example, the GUI performs the singular function of allowing the user to interface with the
device. In short, they are programmable computers, but designed for specific purposes, not

general ones.
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The hardware of embedded systems is based around microprocessors and

microcontrollers. Microprocessors are very similar to microcontrollers, and generally refer

to a CPU that is integrated with other basic computing components such as memory chips

and digital signal processors (DSP). Microcontrollers have those components built into one

chip.

Additionally, embedded systems can include the following characteristics:

comprised of hardware, software and firmware;

embedded in a larger system to perform a specific function as they are built for
specialized tasks within the system, not various tasks;

either microprocessor-based or microcontroller-based -- both are integrated circuits that
give the system compute power;

often used for sensing and real-time computing in internet of things (1oT) devices --
devices that are internet-connected and do not require a user to operate;

vary in complexity and in function, which affects the type of software, firmware and
hardware they use.

often required to perform their function under a time constraint to keep the larger system

functioning properly.

SOFTWARE HARDWARE APPLICATION

Fig: 2.3 Blocks Of Embedded Systems

Embedded systems vary in complexity, but generally consist of three main elements:

Hardware. The hardware of embedded systems is based around microprocessors and
microcontrollers. Microprocessors are very similar to microcontrollers, and generally
refer to a CPU that is integrated with other basic computing components such as memory
chips and digital signal processors (DSP). Microcontrollers have those components built
into one chip.
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- Software. Software for embedded systems can vary in complexity. However,
industrialgrade microcontrollers and embedded 10T systems generally run very simple
software that requires little memory.

- Firmware. Embedded firmware is usually used in more complex embedded systems to
connect the software to the hardware. Firmware is the software that interfaces directly

with the hardware.

2.4\WHY EMBEDDED?

An embedded system is a computer system with a particular defined function within a larger
mechanical or electrical system. They control many devices in common use. They consume

low power, are of a small size and their cost is low per-unit.

Modern embedded systems are often based on micro-controllers. A micro-controller
is a small computer on a single integrated circuit which contains a processor core, memory,
and programmable input and output peripherals. As Embedded system is dedicated to
perform specific tasks therefore, they can be optimized to reduce the size and cost of the

product and increase the reliability and performance.

Fig:2.4 Embedded Systems Hardware

Embedded Systems has brought about a revolution in Science. It is also a part of a
Internet of Things (loT) — a technology in which objects, animals or people are provided
with unique identifiers and the ability to transfer data over a network without requiring
humanto-human or human-to-computer interaction. Well this is just one good thing about
I0T. We can monitor Pollution Levels, we can control the intensity of street lights as per the

season and weather requirements, loT can also provide the parents with real-time
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information about their baby’s breathing, skin temperature, body position, and activity level

on their smartphones and many other applications which can make our life easy.
2.5 DESIGN APPROACHES

A system designed with the embedding of hardware and software together for a specific
function with a larger area is an embedded system design. In embedded system design, a
microcontroller plays a vital role. Micro-controller is based on Harvard architecture, it is an
important component of an embedded system. External processor, internal memory, and i/o
components are interfaced with the microcontroller. It occupies less area and less power
consumption. The application of microcontrollers is MP3 and washing machines.

Critical Embedded Systems (CES) are systems in which failures are potentially
catastrophic and, therefore, hard constraints are imposed on them. In the last years
theamount of software accommodated within CES has considerably changed. For
example,in smart cars the amount of software has grown about 100 times compared to
previousyears. This change means that software design for these systems is also bounded to
hardconstraints (e.g., high security and performance). Along the evolution of CES,
theapproaches for designing them are also changing rapidly, so as to fit the specialized

needsof CES. Thus, a broad understanding of such approaches is missing.

Steps in the Embedded System Design Process

The different steps in the embedded system design flow/flow diagram include the following.

Specification: The first step in the process, where you define the requirements that the

system must meet

Hardware and software partitioning: You divide the system into hardware and software

components

- Hardware and software design: You design approach the hardware and software
independently.
Hardware and software integration: You integrate the hardware and software, and
decide how and when to resolve bugs.

«  Software testing: You test the software to detect vulnerabilities.

« User interface design: You design the interface between the CPU software and the

digital interface logic, and between the digital and analog sides of the interface.
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ABSTRACTION
In this stage the problem related to the system is abstracted.

Hardware — Software Architecture

Proper knowledge of hardware and software to be known before starting any design process.
Extra Functional Properties

Extra functions to be implemented are to be understood completely from the main design.

Abstraction

]

Hardware-software
architecture
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ExtraFunctional
Properties

¥

SystemRelated
Family of Design

¥
Modular Design

¥

Mapping

¥

Userlnterface

L 2
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Fig: 2.5 Embedded Design-Process-Steps
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System Related Family of Design

When designing a system, one should refer to a previous system-related family of design.
Modular Design

Separate module designs must be made so that they can be used later on when required.
Mapping

Based on software mapping is done. For example, data flow and program flow are mapped
into one.

User Interface Design

In user interface design it depends on user requirements, environment analysis and function
of the system. For example, on a mobile phone if we want to reduce the power consumption
of mobile phones, we take care of other parameters, so that power consumption can be
reduced.

Refinement

Every component and module must be refined appropriately so that the software team can
understand.

g D

Embedded system

Software

Application| | Embedded 0S| ¢ * *

Input Output
Hardware

Embedded Peripheral | , o
microprocessor device

. 4

Fig: 2.6 Hardware And Software Of Embedded System
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In user interface design it depends on user requirements, environment analysis and function
of the system. For example, on a mobile phone if we want to reduce the power consumption
of mobile phones, we take care of other parameters, so that power consumption can be

reduced

Table: 2.1 DESIGN PARAMETERS AND FUNCTIONS OF AN EMBEDDED SYSTEM

Design Metrics / Design
Parameters of an
Embedded System

Function

Power Dissipation

Always maintained low

Performance

Should be high

Process Deadlines

The process/task should be completed within a
specified time.

Manufacturing Cost

Should be maintained.

Engineering Cost

It is the cost for the edit-test-debug of hardware

and software.

Size is defined in terms of memory

Size
RAM/ROM/Flash Memory/Physical Memory.
It is the total time taken for developing a system
Prototype o
and testing it.
System safety should be taken like phone locking,
Safety user safety like engine breaks down safety

measure must be taken

Maintenance

Proper maintenance of the system must be taken,

in order to avoid system failure.
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_ Time taken for product to be launched in the
Time to market
market

Architectural description language is used to describe the software design.
- Control Hierarchy

- Data structure and hierarchy

- Software Procedure.

In user interface design it depends on user requirements, environment analysis and
function of the system. For example, on a mobile phone if we want to reduce the power
consumption of mobile phones, we take care of other parameters, so that power consumption
can be reduced.WHO has identified formulations for their local preparation.

Embedded systems are used in a variety of technologies across industries.

Some examples include:

« Automobiles Modern cars commonly consist of many computers or embedded systems,
designed to perform different tasks within the vehicle. Some of these systems perform
basic utility function and others provide entertainment or user-facing functions.

Some embedded systems in consumer vehicles include cruise control, backup sensors,

suspension control, navigation systems and airbag systems.

FOu-—y L'l' @
Smart \\ﬁ Smart health
transport

Acrospace

HCl1

Fig: 2.7 Applications Of Embedded Systems

« Mobile phones These consist of many embedded systems, including GUI software and

hardware, operating systems, cameras, microphones and USB 1/O modules.
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« Industrial machines They can contain embedded systems, like sensors, and can be
embedded systems themselves. Industrial machines often have embedded automation
systems that perform specific monitoring and control functions.

- Medical equipment These may contain embedded systems like sensors and control
mechanisms. Medical equipment, such as industrial machines, also must be very
userfriendly, so that human health isn't jeopardized by preventable machine mistakes.
This means they'll often include a more complex OS and GUI designed for an
appropriate Ul.

The choice of components for the WHO-recommended handrub formulations takes
into account cost constraints and microbicidal activity. The following two formulations are
recommended for local production with a maximum of 50 litres per lot to ensure safety in

production and storage.

2.6 COMBINATION OF LOGIC DEVICES::

Logic gates are physical devices that use combinational logic to switch an electrical one
(“1”) or zero (“0”) to downstream blocks in digital design. Combinational logic uses those
bits to send or receive data within embedded systems.

Logic families are collections of integrated circuits containing logic gates that perform
functions needed by embedded systems to communicate with one another to drive the
design. Logic gates are organized into families relative to the type of material and its

operational characteristics.
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Fig: 2.8 Logic Gates
Most logic gates are made from silicon, although some utilize gallium arsenide or
other semiconductor materials. The semiconductor material is doped for organization into
layers.
22



CHAPTER 3

HARDWARE REQUIREMENTS
3.1 EMBEDDED SYSTEM HARDWARE

Embedded system hardware can be microprocessor- or microcontroller-based. In either case,
an integrated circuit is at the heart of the product that is generally designed to carry out
realtime computing. Microprocessors are visually indistinguishable from microcontrollers.
However, the microprocessor only implements a central processing unit (CPU) and, thus,
requires the addition of other components such as memory chips. Conversely,
microcontrollers are designed as self-contained systems.

Microcontrollers include not only a CPU, but also memory and peripherals such as
flash memory, RAM or serial communication ports. Because microcontrollers tend to
implement full (if relatively low computer power) systems, they are frequently used on more
complex tasks. For example, microcontrollers are used in the operations of vehicles, robots,
medical devices and home appliances. At the higher end of microcontroller capability, the
term.

System on a chip (SOC) is often used, although there's no exact delineation in terms
of RAM, clock speed, power consumption and so on.

It is one of the characteristics of embedded and cyber-physical systems that both
hardware and software must be taken into account. The reuse of available hard- and software
components is at the heart of the platform-based design methodology. Consistent with the
need to consider available hardware components and with the design information flow, we
are now going to describe some of the essentials of embedded system hardware.

Hardware for embedded systems is much less standardized than hardware for
personal computers. Due to the huge variety of embedded system hardware, it is impossible
to provide a comprehensive overview of all types of hardware components. Nevertheless,
we will try to provide a survey of some of the essential components which can be found in
most systems.

Markets and Markets, a business to business (B2B) research firm, predicts that the
embedded market will be worth $116.2 billion by 2025. Chip manufacturers for embedded
systems include many well-known technology companies, such as Apple, IBM, Intel and
Texas Instruments, as well as numerous other companies less familiar to those outside the
field.

23


https://whatis.techtarget.com/definition/processor
https://whatis.techtarget.com/definition/processor
https://whatis.techtarget.com/definition/processor
https://whatis.techtarget.com/definition/processor
https://searchstorage.techtarget.com/definition/flash-memory
https://searchstorage.techtarget.com/definition/flash-memory
https://searchstorage.techtarget.com/definition/flash-memory
https://searchstorage.techtarget.com/definition/flash-memory
https://searchstorage.techtarget.com/definition/flash-memory
https://searchcio.techtarget.com/definition/B2B

The choice of components for the WHO-recommended hand rub formulations takes into
account cost constraints and microbicidal activity. The following two formulations are
recommended for local production with a maximum of 50 litres per lot to ensure safety in

production and storage.

EMBEDDED SYSTEM HARDWARE

Power Supply, Rest and Oscillator Clrowit

Fig: 3.1 Embedded Systems Hardware Block Diagram

The expected growth is partially due to the continued investment in artificial
intelligence (Al), mobile computing and the need for chips designed for that high-level
processing. To be used efficiently, all computer software needs certain hardware
components or other software resources to be present on a computer. These prerequisites are
known as (computer) system requirements and are often used as a guideline as opposed to
an absolute rule.

Most software defines two sets of system requirements: minimum and
recommended. With increasing demand for higher processing power and resources in newer
versions of software, system requirements tend to increase over time. Industry analysts
suggest that this trend plays a bigger part in driving upgrades to existing computer systems
than technological advancements. A second meaning of the term of system requirements, is
a generalisation of this first definition, giving the requirements to be met in the design of a

system or subsystem.
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Often manufacturers of games will provide the consumer with a set of requirements
that are different from those that are needed to run a software. These requirements are
usually called the recommended requirements. These requirements are almost always of a
significantly higher level than the minimum requirements, and represent the ideal situation
in which to run the software. Generally speaking, this is a better guideline than minimum
system requirements in order to have a fully usable and enjoyable experience with that
software.

The most common set of requirements defined by anyoperating systemorsoftware
application is the physical computer resources, also known ashardware, A hardware
requirements list is often accompanied by ahardware compatibility list(HCL), especially in
case of operating systems. An HCL lists tested, compatible, and sometimes incompatible
hardware devices for a particular operating system or application. The following subsections

discuss the various aspects of hardware requirements.

Architecture

All computer operating systems are designed for a particular computer architecture. Most
software applications are limited to particular operating systems running on particular
architectures. Although architecture-independent operating systems and applications exist,
most need to be recompiled to run on a new architecture. See also a list of common operating
systems and their supporting architectures.

Processing power

The power of the central processing unit (CPU) is a fundamental system requirement for any
software. Most software running onx86 architecture define processing power as the model
and the clock speed of the CPU. Many other features of a CPU that influence its speed and
power, like bus speed, cache, and MIPS are often ignored. This definition of power is often
erroneous, as AMD Athlon and Intel Pentium CPUs at similar clock speed often have
different throughput speeds. Intel Pentium CPUs have enjoyed a considerable degree of
popularity, and are often mentioned in this category.

Memory

All software, when run, resides in therandom access memory(RAM) of a computer. Memory
requirements are defined after considering demands of the application, operating system,

supporting software and files, and other running processes. Optimal performance of other
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unrelated software running on a multi-tasking computer system is also considered when
defining this requirement.
Secondary storage

Data storage device requirements vary, depending on the size of software installation,
temporary files created and maintained while installing or running the software, and possible
use ofswap space(if RAM is insufficient).

Display adapter

Software requiring a better than averagecomputer graphicsdisplay, likegraphics editorsand
high-endgames, often define high-enddisplay adaptersin the system requirements.

Peripherals

Some software applications need to make extensive and/or special use of some peripherals,
demanding the higher performance or functionality of such peripherals. Such peripherals

include CD-ROM drives, keyboards, pointing devices, network devices, etc.

Basic Structure of an Embedded System

V. | A-D i‘ Processor& |
’\ SasoL ’;4.‘ Converter }i ASIC Converter Acualot '

Y

j Memory i

Fig: 3.2 Peripherals Of Embedded System

Sensor — It measures the physical quantity and converts it to an electrical signal which
can be read by an observer or by any electronic instrument like an A2D converter. A

sensor stores the measured quantity to the memory.

A-D Converter — As the name implies, the purpose of the analog-to-digital
converter (ADC) is to convert the signal from itsanalog formto a digital data
representation. Due to the physics of converter circuitry, most ADCs require inputs of at
least several volts for their full range input. Two of the most important characteristics of
an ADC are the conversion rate and the resolution. The conversion rate defines how fast

the ADC can convert an analog value to a digital value. The resolution defines how close
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the digital number is to the actual analog value. The output of the ADC is a binary

number that can be manipulated mathematically.

«  Processor & ASICs — Processors process the data to measure the output and store it to

the memory.

- D-A Converter — A Digital to Analog Converter (DAC) converts a digital input signal
into an analog output signal. The digital signal is represented with a binary code, which
is a combination of bits 0 and 1.

- Actuator — An actuator compares the output given by the D-A Converter to the actual

(expected) output stored in it and stores the approved output.

In this loop, information about the physical environment is made available through
sensors. Typically, sensors generate continuous sequences of analog values. In this book,
we will restrict ourselves to information processing where digital computers process discrete
sequences of values. Appropriate conversions are performed by two kinds of circuits:
sample-and-hold-circuits and analog-to-digital (A/D) converters. After such conversion,
information can be processed digitally. Generated results can be displayed and also be used
to control the physical environment through actuators. Since most actuators are analog
actuators, conversion from digital to analog signals is also needed. This model is obviously
appropriate for control applications. For other applications, it can be employed as a first
order approximation. In the following, we will describe essential hardware components of

cyber-physical systems following the loop structure.

They aren’t a lot different to the requirements for working with non-embedded systems. A

lot depends on the purpose of the embedded system. You need to understand:

¢ Requirement set

e Environmental context

e Regulator requirements

¢ Interface specifications, including choice of hardware, and how to drive that hardware

e Criticality of what you are building, including hazards, and any defined mitigation to
those hazards. For instance, is there a safe state to fail to if anything goes wrong.

e Real time constraints, such as cycle times, and time allowable for response. This should
also include hysteresis, response of mechanical components, and backlash.

¢ Real time response from the combination of code, operating system, and hardware you
are working with.
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e Architecture, including any need for redundancy, diversity, fail safety, voting systems,
comparators.

e Platform limitations. Cross compilers, linkers, auto-code generators, etc.

e Choice of operating environment, such as bare metal minimal kernel, real time operating
system, or regular operating system.

e Whether you can rely on your tools. In particular, you need to understand how your tools
can fail, and how you’d know if something went wrong.

e Communications protocols. Synchronous, and asynchronous communications. Error
checking. Error correcting.

e Timingissues, clock rates. Anything that might stop you meeting your real time response
targets, or impact the firing of timers.

e Exception handling.

e Interrupts. How to handle them. How long they take. What the impact is upon responding
to real time response targets.

e How to test on the platform you are working with.

3.2 INTRODUCTION TO ARDUINO

The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14
digital input/output pins (of which 6 can be used as PWM outputs), 6 analogue inputs, a 16

MHz ceramic resonator, a USB connection, a power jack, an ICSP header, and a reset button.
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b

Fig:3.3 Arduino Uno

It contains everything needed to support the microcontroller; simply connect it to a
computer with a USB cable or power it with a AC-to-DC adapter or battery to get started.
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The Uno differs from all preceding boards in that it does not use the FTDI USB-to-serial
driver chip. Instead, it features the Atmegal6U2 (Atmega8U2 up to version R2)
programmed as a USB-to-serial converter.

"Uno" means one in Italian and is named to mark the upcoming release of Arduino
1.0. The Uno and version 1.0 will be the reference versions of Arduino, moving forward.
The Uno is the latest in a series of USB Arduino boards, and the reference model for the

Arduino platform; for a comparison with previous versions.

At its core, an Arduino board consists of a microcontroller (such as ATmega328P on the
Arduino Uno), digital and analog input/output (1/0) pins, power supply components, and
communication interfaces. Users can write programs using the Arduino IDE (Integrated
Development Environment) in a simplified version of C/C++ and upload them to the board
via a USB connection. The board can then process inputs from sensors, buttons, and other

components to control outputs like LEDs, motors, and displays.

Arduino supports a wide range of shields and modules, such as Wi-Fi, Bluetooth,
GPS, and GSM, allowing users to expand its functionality. It is widely used in various fields,
including robotics, home automation, Internet of Things (IoT), industrial control
systems, and education. Due to its affordability, versatility, and strong community
support, Arduino has revolutionized the way people develop electronic projects, making

embedded system development more accessible to everyone.
MAIN PARTS OF ARDUINO UNO:
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Fig:3.4 Arduino Uno Pin Description
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Arduino UNO board is the most popular board in the Arduino board family. In addition, it
is the best board to get started with electronics and coding. Some boards look a bit
differenfrom the one given below, but most Arduinos have majority of these components in

common.
1. Digital Input/Output (1/0) Pins (0-13)

The digital input/output (I/O) pins on an Arduino board, numbered 0 to 13, can be used
for various functions, including reading sensor data and controlling electronic components.
These pins can be configured as either inputs or outputs using the pinMode () function in
the Arduino programming language. Among them, pins 0 (RX) and 1 (TX) are specifically
designated for serial communication, allowing the Arduino to send and receive data via
USB or other communication interfaces.

However, using these pins for general 1/0O while communicating with a computer
may cause issues with uploading code. The remaining pins 2-13 are general-purpose
digital pins, capable of handling HIGH (5V) and LOW (0V) signals, making them ideal
for tasks such as turning LEDs on and off, reading button states, and activating relays.
Additionally, certain pins (3, 5, 6, 9, 10, and 11) support Pulse Width Modulation (PWM),
which enables them to simulate analog output using the analogwrite () function. PWM is
particularly useful for applications like controlling motor speed, adjusting LED
brightness, and generating audio signals. With these digital pins, Arduino provides a
flexible and powerful interface for interacting with the physical world in embedded systems

and DIY electronics projects.
2. Analog Input Pins (A0-A5)

The analog input pins (A0 to A5) on an Arduino board are specifically designed to read
analog signals from sensors and other input devices. These pins use a 10-bit Analog-to-
Digital Converter (ADC), which converts an analog voltage (OV to 5V) into a digital
value ranging from 0 to 1023. This means that the Arduino can measure voltage changes
with a resolution of approximately 4.88 mV per step (5V/1024 steps). Analog input pins
are commonly used for reading sensors such as temperature sensors, potentiometers, light-
dependent resistors (LDRs), and other devices that provide variable voltage outputs.
Additionally, these analog pins can also function as digital 1/O pins if required, giving
users more flexibility in their projects. This dual functionality makes them valuable for

applications where both analog sensing and digital control are needed.
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3. Power Pins

The power pins on an Arduino board provide different voltage levels required to operate
the board and external components. The VIN pin allows the board to be powered using an
external power source, typically between 7V and 12V, which is then regulated to 5V
internally. The 5V pin provides a stable 5V output, which can be used to power sensors,
modules, and other low-power devices. Similarly, the 3.3V pin supplies 3.3V output, useful
for components that require lower voltage, such as certain sensors and communication
modules. The GND (Ground) pins serve as the electrical ground reference, essential for
completing circuits. Additionally, the AREF (Analog Reference) pin is used to set an
external voltage reference for the analog-to-digital converter (ADC), which can improve
the accuracy of analog readings when dealing with specific sensors. Together, these power

pins ensure that the Arduino and its connected peripherals operate efficiently and safely.

4. Communication Pins

Arduino supports multiple communication protocols through its dedicated communication
pins, enabling data exchange with computers, sensors, and other microcontrollers. Serial
communication is handled through pins 0 (RX) and 1 (TX), which allow the Arduino to
transmit and receive data via UART (Universal Asynchronous Receiver-Transmitter).
This is commonly used for connecting the board to a computer via USB or interfacing with
serial devices like Bluetooth modules and GPS receivers. Additionally, Arduino supports
12C (Inter-Integrated Circuit) communication using A4 (SDA) and A5 (SCL) pins.
This protocol enables multiple devices to communicate over just two wires, making
it ideal for connecting sensors, OLED displays, and real-time clocks (RTC). Another
important communication protocol is SPI (Serial Peripheral Interface), which uses pin 10
(SS - Slave Select), pin 11 (MOSI - Master Out Slave In), pin 12 (MISO - Master In
Slave Out), and pin 13 (SCK - Serial Clock). SPI provides high-speed data transfer and is
widely used for interfacing with SD cards, RFID modules, and TFT displays. These
communication pins enhance Arduino’s ability to interact with various external components,

making it a powerful platform for embedded systems and IoT applications.

5. Reset Pin

The RESET pin on an Arduino board is used to restart the microcontroller and reset the
program execution. When this pin is momentarily connected to ground (GND), it forces

31



the Arduino to reboot, clearing all ongoing operations and restarting the code from the
beginning.

This is useful in situations where the microcontroller needs to recover from an error, restart
after a configuration change, or reset external components in a project. Additionally,

pressing the physical reset button on the board also triggers this function.

1 L
: Waichdog PSR -
N Tirmor Supervision '
! POR/BOD & 1
I > RESET .
! Oscillator :
1]
i T L :
¥
' Oscillator ]
I ] Flash SRAM ;
| > Clock T it '
f Generation '
[ )
1 )
| AVR cPu :
' —
! [ EEPROM :
1 ]
H " AVCE
, 3 N :
' 3 7y v _:_ ARFF
: GND
- h 4 v I -
; I 8bit T/C 0 ] [ 16bit T/C 1 I A/D Conv. 3 :
e L
: ! '
' w Analog Internal -
| = 6 '
1 § am e BRauciiacks ] [ Comg. Bandgap | 1 J
B [ .
1 L
i ]
1 '
'
H [ USAHT 0 ] [ SPI I [ T™WI I '
'
: 3 y k. )
1 ]
' r A '
I Y '
[ 1
. 13 3 gl | |
: [ PORT D (8) ] [ PORT B (8) I [ PORT C (7) I i
4 !
- '
I RESET
¥ L
—————————————————————————— XTalL[t. 2y
b A N
FDID. 7] PR{O. 7] PCI0. 6] ADCES. 7]

Fig:3.5 Arduino Block Diagram

3.3 INTRPDUCTION TO GPS

A GPS (Global Positioning System) module is a device used to determine an object's precise
location anywhere on Earth by receiving signals from multiple satellites. It operates based
on trilateration, where the module calculates its position by measuring distances from at
least four satellites in the GPS network.These modules provide real-time data such as
latitude, longitude, altitude, speed, and time, making them essential for navigation, tracking,
and mapping applications. Most GPS modules communicate with microcontrollers like
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Arduino through UART (serial communication) and support standard protocols such as

NMEA (National Marine Electronics Association) for data transmission.

Widely used in vehicles, drones, smartphones, and security systems, GPS modules
play a crucial role in navigation, fleet management, and emergency response services.
Popular models like the NEO-6M and Ublox NEO-M8N offer high accuracy and fast
satellite a ancquisition, often enhanced by external antennas.

Fig:3.6 Gps Module

3.4 INTRODUCTION FOR GSM

A GSM (Global System for Mobile Communications) module is a specialized hardware
device that enables wireless communication through cellular networks. It allows systems to
send and receive SMS (Short Message Service), make voice calls, and access mobile data
by using a SIM card, just like a mobile phone. The module operates over 2G, 3G, or 4G
networks and communicates with microcontrollers like Arduino, Raspberry Pi, or other
embedded systems via UART (serial communication).Most GSM modules support AT
commands (Attention Commands), which are used to configure network settings, send
messages, initiate calls, and access data services.

Commonly used GSM modules include SIM800L, SIM900, SIM7000, and Quectel
M66, each offering different features such as low power consumption, GPS integration, and

LTE (Long-Term Evolution) connectivity. These modules are widely used in applications
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such as 10T (Internet of Things), remote monitoring, security systems, vehicle tracking,

home automation, and industrial automation.

In critical projects like landmine detection and disaster alert systems, GSM modules
play an essential role in providing real-time alerts by transmitting location data and hazard
warnings to authorities. Some advanced GSM modules also support GPRS (General Packet

Radio Service), enabling data transmission over the internet for remote device management.

Fig:3.7 Gsm Module

With their ability to function over long distances without requiring Wi-Fi or wired
connections, GSM modules provide reliable, secure, and cost-effective communication
solutions. Their integration with GPS, loT platforms, and cloud services has further
enhanced their utility in modern smart systems, making them an integral component in

wireless communication and automation technologies.

3.5 INTRODUCTION FOR METAL DETECTOR

An inductive proximity sensor, commonly used as a metal detector, is a non-contact device
that detects the presence of metallic objects using electromagnetic induction. It generates an
alternating magnetic field, and when a metal object enters this field, eddy currents are
induced in the object, altering the sensor’s output signal. These sensors are highly durable
and reliable, as they operate without physical contact, making them ideal for harsh

34



environments. Typically housed in a cylindrical metal body with a plastic or rubber sensing
face, they come with a threaded design for easy mounting and adjustment. Available in NPN
(Normally Open/Closed) or PNP output configurations, they can be integrated into various
circuits and control systems.

4Widely used in industrial automation, these sensors help detect metal parts in
conveyor belts, assembly lines, and robotic systems. In security applications, they are used
in baggage scanners and entrance gates for detecting concealed metal objects. One of their
critical applications is in landmine detection, where they are mounted on robotic systems to

Fig:3.8 Inductive Proximity Sensor(Metal Detector)

Additionally, they play a key role in automotive systems, helping in position sensing
and detecting metallic components. When integrated with microcontrollers like Arduino,
they can trigger alarms, activate LEDs, or send alerts via GSM and GPS modules. Their
ability to provide fast, accurate, and contactless metal detection makes them essential in

various fields, ensuring efficiency and safety in industrial and security applications.

3.6 INTRODUCTION FOR L298

The L298 motor driver module is a robust and widely used motor driver based on the L298N
dual H-Bridge IC, designed for controlling the speed and direction of two DC motors or one
stepper motor. It is commonly used in robotics, automation, and embedded systems due to
its ability to handle high power loads and work efficiently with microcontrollers like

Arduino, Raspberry Pi, and ESP32. The module operates on a motor supply voltage ranging
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from 5V to 35V and can provide up to 2A current per channel. It has TTL logic
compatibility, meaning it can be easily controlled using 3.3V or 5V logic signals.The L298
module consists of two H-Bridges, which allow independent control of two motors,
including forward, reverse, and braking functions. The speed of the motors can be regulated
using Pulse Width Modulation (PWM) by adjusting the duty cycle of the signal applied to
the ENA and ENB pins. For direction control, the module uses four input pins (IN1, IN2,
IN3, and IN4) to toggle between forward, reverse, and stop states for each motor. The OUT1,
OUT2, OUT3, and OUT4 pins connect directly to the motors, allowing current flow to be

controlled accordingly.

Fig:3.9 L298 Motor Driver

A significant advantage of the L298 motor driver module is its built-in protection
circuitry, including diodes for back EMF protection, which prevent damage to the circuit
when motors suddenly stop or change direction. The module also features a large heat sink
to help dissipate heat during extended operation at high currents. Additionally, the 5V
regulator present on some versions of the module provides a stable power supply to
microcontrollers when using an input voltage above 12V.

This motor driver is widely used in various applications such as robotic arms,
obstacle-avoiding cars, CNC machines, conveyor belts, and home automation projects. Due
to its affordability, versatility, and ease of integration, the L298 module remains a popular

choice for both beginners and advanced users in electronics and robotics.
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3.7 INTRODUCTION FOR L293

The L293 motor driver module is a popular quadruple half-H-Bridge motor driver IC that
allows control of the speed and direction of two DC motors or one stepper motor. It operates
on a motor supply voltage range of 4.5V to 36V and can deliver up to 600mA continuous
current per channel, with a peak current of 1.2A per channel. The module is widely used in
robotics, automation systems, and motor control applications due to its ease of interfacing
with microcontrollers such as Arduino, Raspberry Pi, and ESP32.
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Fig:3.10 L293d Motor Driver

The L293 module consists of four half-H-bridges, which allow independent control
of two motors. It has two enable pins (ENA and ENB) to control motor speed via PWM, and
four input pins (IN1, IN2, IN3, and IN4) to regulate motor direction. The output terminals
(OUT1, OUT2, OUTS3, and OUT4) connect directly to the motors. The module also includes
back EMF protection diodes, which safeguard the circuit from voltage spikes caused by
sudden changes in motor direction.Compared to the L298 module, the L293 is more compact
and efficient for low-power applications, making it ideal for small robotic projects, toy cars,
and automation systems. However, for higher current requirements (above 1A per channel),
additional heat sinks or more powerful drivers like the L298 may be preferred. The L293
module remains a reliable and cost-effective choice for basic motor control applications in

electronics and embedded systems.
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3.8 INTRODUCTION FOR POWER SUPPLY

The landmine detection system is powered by a 12V power supply, which provides
electricity to both the Primary and Secondary Arduino boards, as well as various modules
like motor drivers and sensors. The metal detection process is handled by a metal detector
connected to the Secondary Arduino, which continuously scans for metallic objects. When
metal is detected, the Secondary Arduino sends a signal to the Primary Arduino, alerting it
to take necessary actions.

The Primary Arduino acts as the core control unit, receiving and processing data
from multiple modules. The GPS module provides real-time location data, which can be
transmitted via the GSM module through SMS or displayed on an LCD. The 10T module
enables remote monitoring and control, allowing users to access data or update the system
over the internet. When a metal detection alert is received, the Primary Arduino triggers
various output actions, including displaying alerts on the LCD screen, activating a pump via
the L298 motor driver, or controlling the movement of two motors (M1 and M2) through
the L293 motor driver to steer the robotic system accordingly. Additionally, the system
ensures efficient data communication by sending location-based alerts via GSM and
enabling remote access through 10T connectivity. This combination of real-time detection,
GPS tracking, and remote control makes the system a highly effective solution for landmine

detection and security applications.
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CHAPTER 4

SOFTWARE REQUIREMENTS
4.1 SOFTWARE

Embedded system software

A typical industrial microcontroller is unsophisticated compared to the typical enterprise
desktop computer and generally depends on a simpler, less-memory-intensive program
environment. The simplest devices run onbare metaland are programmed directly using the
chip CPU's machine code language.

Often, embedded systems use operating systems or language platforms tailored to
embedded use, particularly where real-time operating environments must be served. At
higher levels of chip capability, such as those found in SoCs, designers have increasingly
decided the systems are generally fast enough and the tasks tolerant of slight variations in
reaction time that near-real-time approaches are suitable. In these instances, stripped-down
versions of the Linux operating system are commonly deployed, although other operating
systems have been pared down to run on embedded systems, includingEmbedded Javaand
Windows IoT (formerly Windows Embedded).

These activities include:

« Setting up a cloud service provider such as Amazon Web Services, Google Cloud, etc.
« Set up private and public keys along with a device certificate.

« Write a device policy for devices connecting to the cloud service

« Connect an embedded system to the cloud service

« Transmit and receive information to the cloud

« Build a basic dashboard to examine data in the cloud and control the device.

 If developers are able to do these things, they will have built a good foundation from

which to master cloud connectivity for their embedded systems.

4.2 ARDUINO SOFTWARE

The Arduino Software (IDE) is the primary platform used to write, compile, and upload
code to Arduino boards. It is an open-source, cross-platform application that works on
Windows, Mac OS, and Linux, making it accessible to a wide range of users. The Arduino
IDE provides a simple yet powerful environment for coding, featuring a user-friendly code
editor with syntax highlighting, line numbering, and auto-indentation to assist in writing

programs, known as sketches.
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PROGRAMMING ARDUINO

Once arduino IDE is installed on the computer, connect the board with computer
using USB cable. Now open the arduino IDE and choose the correct board by selecting
Tools>Boards>Arduino/Genuino Uno, and choose the correct Port by selecting Tools>Port.
Arduino Uno is programmed using Arduino programming language based on Wiring. To
get it started with Arduino Uno board and blink the built-in LED, load the example code by
selecting Files>Examples>Basics>Blink. Once the example code (also shown below) is
loaded into your IDE, click on the ‘upload’ button given on the top bar. Once the upload is
finished, you should see the Arduino’s built-in LED blinking. Below is the example code

for blinking:

ARDUINO - INSTALLATION

After learning about the main parts of the Arduino UNO board, we are ready to learn
how to set up the Arduino IDE. Once we learn this, we will be ready to upload our program
on the Arduino board.

In this section, we will learn in easy steps, how to set up the Arduino IDE on our
computer and prepare the board to receive the program via USB cable.

Step 1: First you must have your Arduino board (you can choose your favorite board) and
a USB cable. In case you use Arduino UNO, Arduino Duemilanove, Nano, Arduino Mega
2560, or Diecimila, you will need a standard USB cable (A plug to B plug), the kind you

would connect to a USB printer as shown in the following image.

Fig: 4.1 Usb A-B Connector
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Step 2: Download Arduino IDE Software.

You can get different versions of Arduino IDE from the Download page on the Arduino
Official website. You must select your software, which is compatible with your operating
system (Windows, 10S, or Linux). After your file download is complete, unzip the file.

Pe

Opening arduino-nightly-windows.zip p—
You have chosen to open:
g arduino-nightly-windows.zip

which is: WinRAR ZIP archive (148 MB)
from: https://downloads.arduino.cc

What should Firefox do with this file?

Open with | WinRAR archiver (default) v

@ SaveFile

Do this automatically for files like this from now on.

OK I ’ Cancel

Fig: 4.2 Aurdino Installation

Step 3: Power up your board.
The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw power from
either, the USB connection to the computer or an external power supply. If you are using an
Arduino Diecimila, you have to make sure that the board is configured to draw power from
the USB connection. The power source is selected with a jumper, a small piece of plastic
that fits onto two of the three pins between the USB and power jacks. Check that it is on the
two pins closest to the USB port.

Connect the Arduino board to your computer using the USB cable. The green power
LED (labeled PWR) should glow.

Step 4: Launch Arduino IDE.
After your Arduino IDE software is downloaded, you need to unzip the folder. Inside the

folder, you can find the application icon with an infinity label (application.exe).
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Doubleclick the icon to start the IDE Launching Arduino refers to starting the Arduino
Integrated Development Environment (IDE), which allows you to write, compile, and

upload code to Arduino boards. Here’s how you can do it

G-Ovl 4. » Computer » LocalDisk (C:) » Program Files » Arduino »
Organize v Include in library v Share with » Bum New folder
d Favorites Name i Date modified Type Size
M Desktop b drivers 9/21/20151:4 PM  File folder
& Downloads ). exaamples 9/21/20151:31 PM  File folder
1 Recent Places 1. hardware 9/21/20151:31 PM  File folde
b jva 9/21/20151:25PM  File foldes
o Libraries ) 9/27/20151:32PM  File folder
Y Documents )i Wbraries 11/19/2015 559 PM  File folde
J Music L reference 9/21/20151:25PM File folde
! Pictures ). tools // 9/21/20151:25PM  File folder
B videos D srduno = 3/16/2014 346 PM  Application B44 K8
o.:wne_dcbuq 9/16/2014 346 PM  Application B
1™ Computer 1% cygiconv-2.41 9/16/2014 346 PM  Applicatic o4
& Local Disk (C:) % cygwinl.dil 9/16/2014 346 PM  Application otens 1829 %8
e MTCMASTER (D) % hbush0.dil 3/16/2014 346 PM  Applicatic 4
u INFORMATION TECHNOLOG | | revisions 9/16/2014 346 PV Text Docur X
% nSedial.dil 9/16/2014 346 PM  Application etens 7%
S Network & uninstal 9/21/0151:26PM  Application 402 K8

Fig: 4.3 Opening Aurdino lde
Step 5: Open your first project.
Once the software starts, you have two options:
[] Create a new project.
[J Open an existing project example.

To create a new project, select File --> New

D sketch _now20a | Arduine 108
[File] €6t Setch Tocls Help
Horw Cul«N
Open. CirleD
ummn\
Examples
Close Culew
Seve Curle$
Save Aa. Cirl e Shafte§
Upload Crl=l)
Upload Using Programmer  Ctrl+ Shifts U Q
Page Setup Ctel s Shalt= P
Prrt Cel«P
Preferences Ctrls Comma
Quit CrleQ .

Fig: 4.4 Creating New Project
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To open an existing project example, select File -> Example -> Basics -> Blink.
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Fig: 4.5 Example Programs

Here, we are selecting just one of the examples with the name Blink. It turns the LED on
and off with some time delay. You can select any other example from the list.

Step 6: Select your Arduino board.

Teensy32/31
Teensy 3.0
Teensy LC
2 Blink | Arduino 106 | |l
File Edt Sketch (Tools) Help i
Auto Format Ctrle T SijfAxkinotioe
S Arduino Duemilanove w/ ATmega328
Blnk§ Fix Encoding & Reload Arduino Diecimila or Duemilanove w/ ATmegal6s
Serial Monitor CuteShiftem| | ArduinoNano w/ ATmegs228
Arduino Nano w/ ATmegal 68
Board: "Arduino Uno” » Arduino Mega 2560 or Mega ADK
Serial Port L4 Arduino Mega (ATmegal280)
US8 Type . Arduino Leonardo
CPU Speed » Arduino Esplora
Keyboard Layout L Arduino Micro
ProRme A Arduino Mini w/ ATmega328
Buisi Bootloader Arduino Mini w/ ATmegalss
Arduino Ethernet
Arduino Fio
Arduino BT w/ ATmega328
Arduino BT w/ ATmegal68
LilyPad Arduino USB
LilyPad Arduino w/ ATmega32s

LilyPad Arduino w/ ATmegal68

Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmega328
Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmegal8
Arduino Pro or Pro Mini (33V, 8 MHz) w/ ATmega328
Arduin Pro or Pro Mini (33V, 8 MHz) w/ ATmegal68
Arduino NG or older w/ ATmegal68

Arduino NG or oider w/ ATmega8

Arduino Robot Control

Arduino Robot Motor

Fig: 4.6 Selecting Board
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To avoid any error while uploading your program to the board, you must select the correct

Arduino board name, which matches with the board connected to your computer.

Go to Tools -> Board and select your board.

Here, we have selected Arduino Uno board according to our tutorial, but you must select the

name matching the board that you are using.

Step 7: Select your serial port.

Select the serial device of the Arduino board. Go to Tools -> Serial Port menu. This is likely

to be COM3 or higher (COM1 and COM2 are usually reserved for hardware serial ports).

To find out, you can disconnect your Arduino board and re-open the menu, the entry that

disappears should be of the Arduino board. Reconnect the board and select that serial port.

i

2 Blink | Arduino 1.0.6

Blink &

File Edit Sketch [Tools| Help

Auto Format
Archive Sketch

Fix Encoding & Reload

Senal Menitor

Board: "Arduing Uno®

Senal Port

Programmer

Burn Bootloader

Ctrl+T

Ctil+Shift+M

N
= §oR =~

coml
Comz2
com3

Arduine Une an COMIE

Fig: 4.7 Selecting Port
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Step 8: Upload the program to your board.
ARDUINO - PROGRAM STRUCTURE

we will study in depth, the Arduino program structure and we will learn more new
terminologies used in the Arduino world. The Arduino software is open-source. The source
code for the Java environment is released under the GPL and the C/C++ microcontroller
libraries are under the LGPL.

Sketch: The first new terminology is the Arduino program called “sketch”.

Structure Arduino programs can be divided in three main parts: Structure, Values (variables
and constants), and Functions. In this tutorial, we will learn about the Arduino software
program, step by step, and how we can write the program without any syntax or compilation
error.

Let us start with the Structure. Software structure consist of two main functions:

[J Setup( ) function

[ Loop( ) function

D cketch_nov29a | Arduino 1.0.6 = =
File Edit Sketch Tools Help

Fig: 4.8 Code Editor

PURPOSE: The setup() function is called when a sketch starts. Use it to initialize the
variables, pin modes, start using libraries, etc. The setup function will only run once, after

each power up or reset of the Arduino board.
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INPUT:
OUTPUT:
RETURN:

PURPOSE: After creating a setup() function, which initializes and sets the initial values, the
loop() function does precisely what its name suggests, and loops consecutively, allowing
your program to change and respond. Use it to actively control the Arduino board.

INPUT: -

OUTPUT: -

RETURN:

download and install a tool like balena etcher or raspberry pi imager (even though
you can use imager to download as well, it works for manually flashing). open the tool and
select the .img file you downloaded and extracted.select your microsd card as the target.
click "flash" or "write" to write the os image to the microsd card. o eject the microsd card:
once the flashing process is complete, safely eject the micro-sd card.
first boot setup
1. insert the micro-sd card into your raspberry pi.
2. connect your raspberry pi to a monitor, keyboard, and mouse.
3. power it on by plugging in the power supply (5v, 3a for the raspberry pi 4).
4. on the first boot, raspberry pi os will run a setup process:

4.3 RESEARCH

The embedded systems industry was born with the invention of microcontrollers and since
then it has evolved into various forms, from primarily being designed for machine control
applications to various other new verticals with the convergence of communications. Today
it spans right form small metering devices to the multi-functional smartphones. | will cover
the areas that are currently focused for development in embedded systems and state what

are the ongoing research opportunities in that particular area.

Security

Security remains a great challenge even today. Ongoing Research is to sustain physical
tampering, mechanisms to trust the software, authenticate the data and securely
communicate over internet. With the advent of 10T/IoE, not only the number devices will
continue to increase but also will the number of possible attack vectors. Many challenges
remain ahead to get the connected devices on a billion scale.
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Connectivity

Wi-Fi, BLE, ZigBee, Thread, ANT, etc have been adapted by embedded system experts
from considerable time. Head-on competition between these groups is in progress to
determine as to who will emerge as the best solution provider to this huge estimated market
of lI0T/IoE. 4G/5G on low power devices is the ongoing experimentation which will make
embedded systems easily and robustly connect to the internet. Communication using
GSM/LTE in licensed/unlicensed communication bands with the cloud can change the ball
game of IoE all together.

Memory

Various type of volatile/non-volatile memories with variable sizes and speeds are widely
available today. Research is more towards organizing them in best possible architecture to
reach closer to the design goal of optimal power-performance-cost.

Energy

Power/Battery management has been under focus for some time. Usage of renewable
resources to power device's lifetime is currently the challenge that is tried to address;
especially for wearables. Optimal power usage to get Longer Battery Life with new
Hardware/Software architectural designs will continue for some time. System .

Multicore (Symmetric/Asymmetric) architectures are experimented since long.
Addition of GPUs to systems for VR/Gaming/Machine learning is addressed currently
Programmable SOCs (PSOCs) - (Configurable Hardware Capability) have been there for a
long time now, but some has not yet gained momentum. Application-specific computer
architectures is also in the pipeline in order to optimize the design matrix of
powerperformance-cost.

Performance
Real-time on-board Image/Video/Audio processing, feature enabled cameras, on board
machinelearning are all currently experimented with varied approaches.

Commercialization of these technologies has already started but there is still some
time to get the best out of these technologies and there is lot of scope to make them more
userfri
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CHAPTER 5
WORKING MODEL AND COMPONENTS
5.1 BLOCK DIAGRAM

This block diagram represents a landmine detection system using Arduino Uno. The
Arduino acts as the central controller, powered by a battery, and connects to various
components. A metal detector senses underground mines, triggering the buzzer and LED
indicators for alerts. The GPS module provides the exact location of the detection, while the
GSM module sends this information via SMS. Bluetooth enables wireless monitoring and
control. The L298 motor driver operates two motors (M1 and M2), allowing movement
across terrain. This automated system ensures efficient landmine detection with real-time

alerts, combining safety, mobility, and remote communication in field operations.

POWER SUPPLY / BATTERY
\4
> GPS
BUZZER A
v > GSM
LED’S |« R
D
' p »| BLUETOOTH
N
ML 1
1298 MOTOR o)
DRIVER
UNO METAL DETECTOR /
M2 PROXIMITY
SENSOR
Fig:5.1 Block Diagram
5.2 WORKING

The Land Mine Detector with Automatic Indication using GPS and GSM is an advanced
system designed to detect land mines and provide real-time location updates via GPS and
GSM technology. The system operates using two Arduino Uno microcontrollers one

primary and one secondary working together to control various components.The metal
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detector is connected to the secondary Arduino Uno, which processes signals and sends
detection alerts to the primary Arduino Uno. The primary Arduino serves as the central
control unit, managing communication between different modules. When a land mine is
detected, the system triggers an alert that is transmitted via the GSM module to notify
concerned authorities. Simultaneously, the GPS module records the exact coordinates of the
detected mine and sends this information for further action.

To enable autonomous movement, the system utilizes two motor driver modules
L298 and L293 which control motors m1 and m2 for navigation. These motor drivers receive
movement commands from the primary Arduino, allowing the robot to maneuver efficiently.
Additionally, the project incorporates loT capabilities, enabling remote monitoring and
control.A power supply unit ensures consistent energy distribution to all components,
ensuring the system functions effectively in field operations. The integration of GSM, GPS,
and loT makes this project highly efficient for detecting and marking hazardous landmine

locations, thereby aiding demining operations and enhancing safety in affected areas.

Components and Connections

» Arduino Uno (Primary and Secondary)

e Primary Arduino handles the main logic and communication with other modules.

e Secondary Arduino is connected to a metal detector and sends detection signals to the
Primary Arduino.

> Power Supply (12V)

e The 12V power supply provides the required power to the system.

e CONNECTIONS:

e Connect the 12V power supply to the Vin and GND pins of both Arduino boards
(Primary and Secondary) through a voltage regulator, if needed.

> Metal Detector

o Purpose: Detects metal objects and sends a signal to the Secondary Arduino.

e CONNECTIONS:

e VCC (Power) — Connect to the 5V pin on the Secondary Arduino.

e GND — Connect to GND on the Secondary Arduino.

e Signal Output — Connect to a digital input pin (e.g., D2) on the Secondary Arduino.

> 1oT Module (e.g., ESP8266 or ESP32)

e Purpose: Provides wireless connectivity for 10T features.

e CONNECTIONS:
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VCC - Connect to 3.3V or 5V (depending on the module requirements) on the
Primary Arduino.

GND — Connect to GND on the Primary Arduino.

TX — Connect to the RX pin on the Primary Arduino (e.g., D2).

RX — Connect to the TX pin on the Primary Arduino (e.g., D3).

If using an ESP8266, you may need a level shifter if the Arduino operates at 5V logic.
GSM Module (e.g., SIM800L)

Purpose: Provides GSM communication for sending data such as GPS location.
CONNECTIONS:

VCC - Connect to 5V on the Primary Arduino.

GND — Connect to GND on the Primary Arduino.

TX — Connect to a digital input pin (e.g., D4) on the Primary Arduino.

RX — Connect to a digital output pin (e.g., D5) on the Primary Arduino.

Note: Some GSM modules require a separate power supply or voltage regulator due to
their high power consumption.

GPS Module (e.g., NEO-6M)

Purpose: Provides GPS data to the Primary Arduino.

CONECTIONS:

VCC - Connect to 5V on the Primary Arduino.

GND - Connect to GND on the Primary Arduino.

TX — Connect to the RX pin (e.g., D6) on the Primary Arduino.

RX — Connect to the TX pin (e.g., D7) on the Primary Arduino.

> LCD Display (16x2)

Purpose: Displays information such as GPS location or system status.
CONNECTIONS:

VCC — Connect to 5V on the Primary Arduino.

GND — Connect to GND on the Primary Arduino.

RS — Connect to a digital pin (e.g., D8) on the Primary Arduino.

E — Connect to another digital pin (e.g., D9) on the Primary Arduino.
D4-D7 — Connect to digital pins (e.g., D10 to D13) on the Primary Arduino.
RW — Connect to GND (for write-only mode).

> L.298 Motor Driver (for Pump Control)

Purpose: Controls the operation of a pump.
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CONNECTIONS:

VCC — Connect to the 12V power supply.

GND — Connect to GND on the Primary Arduino.

IN1/IN2 — Connect to digital pins (e.g., D10, D11) on the Primary Arduino fodirection
control.

OUT1/0OUT2 - Connect to the pump motor terminals.

L293 Motor Driver (for Motor M1 and M2)

Purpose: Controls the operation of two motors (M1 and M2).

CONNECTIONS:

VCCL1 (Logic Voltage) — Connect to 5V on the Primary Arduino.

VCC2 (Motor Voltage) — Connect to the 12V power supply.

GND - Connect to GND on the Primary Arduino.

IN1, IN2 — Connect to digital pins (e.g., D12, D13) on the Primary Arduino for Motor
M1 control.

IN3, IN4 — Connect to additional digital pins (e.g., D4, D5) on the Primary Arduino
for Motor M2 control.

OUT1/0OUT2 — Connect to Motor M1 terminals.

OUT3/0OUT4 — Connect to Motor M2 terminals.

Table:5.1 PIN SUMMARY

Component Connection Pin on Arduino Description
Power Supply Vin, GND 12V power input
Metal Detector D2 (Secondary Arduino) Detects metal
loT Module D2 (TX), D3 (RX) Sends/receives data
GSM Module D4 (TX), D5 (RX) Sends location
GPS Module D6 (TX), D7 (RX) Receives GPS data
LCD Display D8, D9, D10-D13 Display information
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Component Connection Pin on Arduino Description
L298 Pump Driver D10, D11 Pump control

L293 Motor Driver D4, D5, D12, D13 Controls motors M1 and M2

1. Metal Detection Sequence:

o Secondary Arduino detects metal and sends a signal to Primary Arduino.

e Primary Arduino logs data and optionally notifies the user through the GSM module.
2. Location Update Sequence:

e Primary Arduino reads coordinates from the GPS module.

« Sends location data to GSM module for transmission to a remote server or device.

3. Motor Control Sequence:

e Primary Arduino receives a command via IoT module to control motors.

e Primary Arduino activates L293 to start/stop Motor M1/M2.

Class diagram:

Since Arduino setups are typically procedural rather than object-oriented, we would adapt
the class diagram to show components and interfaces. Here, each hardware module can be

represented as a class with properties and methods to simulate interaction.

Ardunio
metal gps gsm iot Icd motor
detector
remote
server

Fig:5.2 Class Diagram
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Classes:

Arduino: Primary and Secondary classes

Properties: Inputs, Outputs, Power.

Methods: SendData(), ReceiveData(), ControlMotor(), DisplayData().
GSM Module:

Properties: SIM number, Message queue.

Methods: SendSMS(), ReceiveSMS().

GPS Module:

Properties: Coordinates

Methods: UpdateLocation().

Motor (M1, M2):

Properties: Speed, Direction.

Methods: StartMotor(), StopMotor(), ChangeSpeed().
Pump:

Properties: Status (On/Off).

Methods: StartPump(), StopPump().
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CHAPTER 6
RESULTS

The Landmine Detector with Automatic Indication using GPS and GSM s designed to
enhance mine detection efficiency and improve safety in hazardous areas. The system
successfully identifies buried landmines using a metal detector sensor, which triggers an
alert when a metallic object is detected. Upon detection, the GPS module captures the
precise coordinates of the landmine location, ensuring accurate mapping of mine-infested
areas. Simultaneously, the GSM module sends an automatic SMS alert containing the
location details to predefined contacts such as military personnel or bomb disposal teams,

allowing for swift response and clearance operations.

Fig: 6.1 Robot System Is On

To ensure immediate awareness, the system is equipped with buzzer and LED indicators
that activate instantly upon detecting a landmine. This feature helps field operators take

necessary precautions and mark hazardous zones efficiently.
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The system is designed to be portable, battery-powered, and field-deployable, making it
suitable for military and humanitarian demining missions. Additionally, the system can log

detected landmine locations, creating a database that aids in large-scale demining efforts.

Fig: 6.2 Robot System Detected The Land Mine Metal

The overall outcome of the project is a highly efficient, accurate, and automated
landmine detection system that enhances security and safety in conflict-prone areas. By
integrating GPS and GSM technologies, the system ensures real-time tracking and
communication, reducing the risk of accidental explosions and safeguarding human lives.
This innovative approach makes the landmine detector a crucial tool for defense forces,

security agencies, and humanitarian organizations engaged in mine clearance operations.

Fig: 6.3 Location Of Land Mine Using Gps
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ADVANTAGES
1. Life-Saving Technology

The landmine detection system significantly reduces human risk by detecting mines without
the need for direct human intervention. This minimizes the chances of accidents, allowing
experts to focus on safely deactivating mines rather than searching for them manually. It is
particularly beneficial in war-affected areas, where civilians may unknowingly enter

dangerous zones, helping prevent casualties.

2. High Accuracy and Efficiency

The system offers high accuracy and efficiency in landmine detection by using precise GPS
tracking to pinpoint the exact location of mines. It operates through automated scanning,
detecting mines much faster than traditional manual methods. Unlike human operators, who
can become fatigued or make mistakes, this system works consistently, ensuring reliable and

efficient detection.

3. Real-Time Alerts and Communication

Real-time alerts are one of the system’s key features. Upon detecting a mine, it sends instant
SMS notifications with the exact GPS coordinates to the relevant authorities, such as
rescue teams or military units. Moreover, the system can be integrated with 10T, enabling
remote monitoring and data logging for future use, aiding in long-term safety and planning.

4. Cost-Effective and Scalable

The landmine detection system is a cost-effective solution, reducing the need for expensive
human resources and specialized demining squads. Additionally, the system is highly
scalable, allowing for deployment across larger areas using different platforms such as
robots, drones, or autonomous vehicles. Unlike traditional demining tools that may get

damaged, this system can be reused, further lowering operational costs.

5. Versatile and Adaptable

The system is versatile and adaptable, able to function in a variety of terrains, including
deserts, forests, mountains, and war zones. It can also be customized with various
detection mechanisms, such as metal detectors, ground-penetrating radar (GPR), or Al-
based recognition, providing flexibility and improving the accuracy of detection.
Additionally, it can be repurposed t0 detect other hazards, such as buried cables or 1EDs.
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6. Supports Military and Humanitarian Missions

This technology plays a critical role in both military and humanitarian demining
missions. It helps military and security forces detect mines in conflict zones, enhancing their
operational safety. Post-conflict, it supports disaster management efforts by enabling the
safe clearance of minefields, facilitating the resettlement of civilians. Additionally, it aids
organizations like the UN Mine Action Service (UNMAS) and other NGOs in global
demining operations.

7. Eco-Friendly and Non-Destructive

Unlike traditional demining techniques that may detonate mines, causing environmental
destruction, this system is non-explosive and non-destructive. It detects landmines without
disturbing the environment, thus preventing soil degradation and minimizing ecosystem
disruption. This eco-friendly approach is more sustainable and safer for both people and

the surrounding environment.

APPLICATIONS
1.Military and Defense Applications

The landmine detection system plays a vital role in military and defense operations. It is
used extensively in war zones to locate landmines and ensure the safety of military
personnel. In border security, it helps identify hidden mines and explosive traps, securing
critical areas. The system is also employed in military training grounds to clear areas of
unexploded ordnance (UXO), preventing accidents during exercises. Furthermore, it aids in
anti-terrorism operations by detecting Improvised Explosive Devices (IEDs) planted by

insurgents.

2. Humanitarian and Civilian Safety

The landmine detection system is essential for humanitarian efforts. After conflicts, it
helps in post-war mine clearance, ensuring safe land for resettlement and rebuilding
communities. The system supports organizations like UNMAS, the Red Cross, and the
HALO Trust, which are involved in global mine-clearance missions. It also ensures the
safety of refugee camps in post-war areas by detecting hidden explosives, and it aids in
civilian land recovery, allowing farmers and landowners to reclaim land previously
contaminated by landmines.
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3. Disaster Management and Emergency Response

In disaster management, the landmine detection system is crucial for natural disaster
recovery, as mines displaced by events like earthquakes or floods need to be located and
neutralized. The system is used to scan roads and fields for mines before they are reopened
to civilians. It also ensures safe pathways for search and rescue operations during
emergencies, helping rescue teams operate safely in areas previously contaminated with

explosives.

4. Robotics and Autonomous Systems

The system can be integrated into robotic vehicles for autonomous landmine detection,
improving efficiency and reducing risk. Drones equipped with GPS and GSM modules
can cover large areas, scanning minefields quickly and effectively. Additionally,
autonomous surveillance systems can be deployed in military bases or remote areas,
continuously monitoring for potential threats without human intervention, enhancing safety

and security.

5. Industrial and Infrastructure Applications

The landmine detection system is also valuable in industrial and infrastructure projects.
Before construction begins in previously war-affected areas, the system ensures that the
land is free of mines, protecting workers and machinery. It is also used in the oil and gas
industry to scan for underground hazards, such as mines or explosives, before laying
pipelines in high-risk areas. The system can be adapted for underground cable detection,
reducing the risks associated with excavation in potentially hazardous sites.

6. Security and Law Enforcement

In security operations, the landmine detection system supports bomb disposal units by
helping them detect and neutralize explosive devices safely. It is also used in high-security
environments like VIP events, stadiums, and public spaces, where it helps identify hidden
explosives to prevent terrorist attacks. Furthermore, it assists in crime scene investigations
by helping forensic teams locate buried explosive devices that may have been used in

criminal activities.
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CHAPTER 7

CONCLUSION AND FUTURE SCOPE
CONCLUSION

The paper introduces an innovative solution and a novel approach to remote sensing using
metal detectors to detect metallic landmines in the EI Alamein region. The proposed
advanced solution addresses three key challenges: a) the lack of maps indicating the
locations of landmines planted during World War Il in the Egyptian western desert, b)
limited funds available for addressing the issue, and c) the restricted utilization of
technology. To overcome these challenges, the solution integrates various technologies,
including wireless communications, cellular technologies, and packet-oriented mobile data
services. This integration enables the landmine monitoring team to maintain complete
control over the process from a safe distance, particularly in fenced minefields or suspicious
areas.

The solution combines several components such as GSM sound trackers, GPS
trackers, smart cellphones, advanced applications, and RC truck equipment to accomplish
three primary tasks related to metal landmines: a) tracing, b) detecting, c) pinpointing the
location coordinates, and d) marking the location. The paper presents a cutting-edge solution
that leverages integrated technologies, wireless communication, and mobile data services to
detect metallic landmines in the ElI Alamein region. By addressing the absence of maps,
financial limitations, and technological constraints, this approach offers a comprehensive

and efficient method for remote sensing and monitoring of landmines.

FUTURE SCOPE

The future scope of a landmine detector with automatic indication using GPS and GSM is
vast and promising, driven by advancements in Al, robotics, 10T, and remote sensing
technologies. In the coming years, Al and machine learning will enhance detection accuracy
by differentiating between landmines and other buried objects, reducing false alarms.
Autonomous robots and drones equipped with advanced sensors and GPS tracking will
enable faster, safer, and more efficient minefield scanning, reducing the need for human
intervention. Additionally, multi-sensor fusion technology, such as ground-penetrating radar
(GPR), infrared sensors, and electromagnetic detectors, will improve detection capabilities

by identifying deeply buried or non-metallic mines.
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The integration of 10T and cloud-based monitoring will allow real-time mine
detection updates, enabling global access to minefield data for humanitarian and military
organizations. Smartphone applications and GIS-based mapping systems will facilitate
better visualization of detected mines, helping authorities plan safer routes and demining
operations. Future developments may also focus on eco-friendly detection methods, such as
using bacteria or plant-based biosensors to identify explosives. Furthermore, solar-powered
and low-energy loT-based devices will enhance operational efficiency in remote areas by

ensuring continuous functionality without frequent maintenance.

From a defense and national security perspective, the evolution of mine detection
will lead to automated mine-neutralizing combat vehicles, ensuring safer battlefield
navigation for military personnel. Real-time battlefield analysis through Al-driven data
processing will help strategize troop movements and enhance security measures. In the
humanitarian sector, these advancements will significantly accelerate post-war demining
operations, allowing displaced communities to return safely to their lands. Additionally,
international organizations like the UN and NGOs will benefit from standardized, automated

detection solutions to achieve global mine-free zones.

As technology continues to advance, the combination of Al, robotics, 0T, and
energy-efficient systems will revolutionize landmine detection, making it safer, faster, and
more accurate. These innovations will not only improve military operations but also

contribute significantly to humanitarian efforts, ensuring a safer and mine-free world.
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APPENDIX
Appendix-1: Gather Components

Before beginning the project, ensure all essential components are collected:

Arduino Uno (Primary & Secondary) — Controls system logic and metal detection
Metal Detector Sensor — Detects buried metallic landmines

GSM Module (SIM800L) — Sends SMS alerts with GPS data

GPS Module (NEO-6M) — Provides geographic coordinates

IoT Module (ESP8266/ESP32) — Enables wireless connectivity and data logging
L298 Motor Driver — Controls motor for pump or movement

L293 Motor Driver — Drives M1 & M2 motors

Motors M1 & M2 — Enable autonomous movement

© © N o g~ w D

LCD Display (16x2) — Displays status, alerts, and coordinates

10. Power Supply (12V) — Provides power to the system

11. Voltage Regulator — Manages voltage to prevent damage

12. Rechargeable Battery Pack — Powers the system in the field

13. Jumper Wires, Breadboard, Mounts — For prototyping and integration
14. Chassis or Robot Frame — Physical structure for mounting components

Appendix-2: Circuit Design & Wiring
2.1: Power Supply Connections
e 12V Power — Connected to Vin of both Arduino boards
e Voltage Regulator — Ensures regulated power to GSM, GPS, and sensors
2.2: Metal Detector to Secondary Arduino
e VCC—-5V
e GND — GND
e Output — D2 (Secondary Arduino)
2.3: GSM Module (SIM800L) to Primary Arduino

e VCC—-5V

e GND — GND

e TX —D4

e RX—>D5

2.4: GPS Module (NEO-6M)
e VCC—-5V

e GND — GND
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e TX —D6

e RX — D7

2.5: 10T Module (ESP8266/ESP32)

e VCC — 3.3V or 5V (based on module)
e GND — GND

e TX—>D2

e RX—>D3

2.6: LCD Display (16x2)

e VCC—-5V

e GND — GND

e RS —DS8

e E—D9

e D4-D7 — D10-D13

e RW —=GND

2.7: L298 Motor Driver (Pump or Movement)
e VCC— 12V

e GND — GND

e INI1/IN2 — D10, D11

e OUTI1/OUT2 — Pump Motor

2.8: L293 Motor Driver (Motors M1 & M2)
e« VCCI -5V

e« VCC2— 12V

e GND — GND

« IN1/IN2 — D12, D13 (M1)

o IN3/IN4 — D4, D5 (M2)

e OUTI/OUT2 — Motor M1

e OUT3/0UT4 — Motor M2

Appendix-3: Arduino IDE Setup
e Install Arduino IDE
e Add support for ESP8266 / ESP32 if using IoT modules
o Install required libraries:
e SoftwareSerial.h

e LiquidCrystal.h
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o TinyGPS++.h (for GPS)
e Adafruit_Sensor (optional, for 10T sensors)
Test each module with basic sketches (LCD print, GSM SMS, GPS read)

Appendix-4: Writing the Firmware

Secondary Arduino (Metal Detection)

o Read digital input from metal detector

e Send signal to Primary Arduino via Serial or digital pin
Primary Arduino

e Receive detection signal

o Get GPS coordinates

e Send SMS via GSM module

e Update LCD display

e Drive motors (M1/M2) using L293

e Control pump (optional) via L298

e Send data via ESP8266 to loT dashboard

Appendix-5: System Testing

Test metal detection sensor and communication between Arduinos
Verify GPS module outputs valid coordinates

Check GSM module for SMS alerts

Run motor drivers with dummy movement commands

Confirm LCD shows system status

Send mock detection data to cloud via ESP module

Appendix-6: Assembly and Enclosure

Mount all modules securely on robot chassis

Isolate power lines and use heat shrink sleeves for safety
Ensure metal detector is near the ground

Place GPS and GSM antennas in open, elevated position
Design a compact enclosure using acrylic or 3D printed frame

Appendix-7: Final Integration and Optimization

Calibrate motor speeds and metal detector sensitivity
Optimize GPS refresh interval
Add delays or buffer for GSM transmission
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o Test continuous operation for 2—-3 hours

o Implement energy-saving techniques (sleep modes)

Appendix-8: Maintenance & Monitoring

Clean and inspect metal detector coil regularly
Check GSM SIM balance and signal strength

Charge battery pack before field deployment

Monitor logs from cloud dashboard (if 10T is enabled)

Update firmware for bug fixes or feature upgrades
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